
Affiliate Pdf Dispenser Installation And Use

Promoting products through viral PDF reports is a proven strategy used by most of the top online 
marketers. It's a method responsible for millions of dollars in sales across the Internet.

Affiliate PDF Dispenser provides a quick and easy solution to make your reports instantly brandable in 
a way that even a complete newbie affiliate can use. Although the Dispenser script is easy for you and 
your affiliates, there may still be times when you prefer to use a traditional .exe PDF branding tool 
instead.
 
So a bonus copy of our Affiliate PDF Brander - one of the best traditional brander tools on the market - 
is included.  This software really is a very valuable asset for anyone serious about online business.

To see how we use the software please visit http://thebestofwww.com/brandablepdf/

This will give you an idea of just how powerful this software is. Keep in mind, you can use a single 
installation of the script to handle an unlimited number of PDF reports. You just upload all the reports 
into the same folder as the script.
 
Your affiliates, or web visitors, just enter their details into the form and then the script will show a full 
set of download links (one for each report). Each report will be automatically branded with the 
affiliates details during download.
 
You can add more reports at any time, just by uploading them into the same folder as the script - and 
you can replace or remove reports whenever you want.
 
In addition, you can also install an unlimited number of copies of the script on as many websites as you 
want (as long as they are all owned by you). So you only need to order one copy of the software to 
provide quick and easy PDF branding for your entire business.
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Create Your PDF Files

It is recommended that you use OpenOffice to create your PDF files.

This is available free from http://www.openoffice.org

Most other PDF creators do not generate PDF files that are compatible with this software. If you want 
to check whether a PDF creator is compatible, just try it. The software will tell you if your PDF file is 
not compatible.

To create a PDF using OpenOffice, open your document file (.doc, .txt or .odt file) in the OpenOffice 
Writer then use the Export as PDF function in the File menu.

If you want to insert links into your document, use the Hyperlink function in the Insert menu in the 
OpenOffice Writer.
 

Creating Reports With A Single Affiliate ID

The most common use of this script is with reports that contain a single affiliate ID.

All links that are to be customized with the affiliate ID should have the text "AAAA" in the link where 
the affiliate ID is to be inserted.

You can have lots of different affiliate links containing the ID.

For example, a typical affiliate link might look like this:

http://www.mysite.com/cgi-bin/affiliates/refer.cgi?r=AAAA

An example Clickbank link might look like this:

http://AAAA.myebook.hop.clickbank.net

When an affiliate (or user) brands the PDF file, they will be asked to enter their affiliate ID and then 
the software will replace AAAA with their affiliate ID.

Hence in our examples, if an affiliate (or user) entered an affiliate ID of myid, the example links would 
become:

http://www.mysite.com/cgi-bin/affiliates/refer.cgi?r=myid

and

http://myid.myebook.hop.clickbank.net 

 

http://www.openoffice.org/
http://www.openoffice.org/
http://www.openoffice.org/


Creating Reports With A Multiple Affiliate IDs and/or Links

You can also use this script with reports that contain up to four different affiliate IDs and up to six 
different links, all of which can be customized with the details for each affiliate.

The setup of the script and PDF file is more complicated in this case and is aimed at more advanced 
users.

All links that are to be customized with the first affiliate ID should have the text "AAAA" in the link 
where the affiliate ID is to be inserted.

All links that are to be customized with the second affiliate ID should have the text "BBBB" in the link 
where the affiliate ID is to be inserted.

All links that are to be customized with the third affiliate ID should have the text "CCCC" in the link 
where the affiliate ID is to be inserted.

All links that are to be customized with the fourth affiliate ID should have the text "DDDD" in the link 
where the affiliate ID is to be inserted.

All links that are to be customized with the fifth affiliate ID should have the text "EEEE" in the link 
where the affiliate ID is to be inserted.

All links that are to be customized with the sixth affiliate ID should have the text "FFFF" in the link 
where the affiliate ID is to be inserted.

For the six customizable links, just insert links into the PDF file as normal.
See the section below "Handling Reports With A Multiple Affiliate IDs and/or Links" for details of 
how to set up your script to customize your reports.

 
Naming Your PDF Files

It's recommended that you name your PDF files with upper case letters at the start of each word, to 
make the names more readable for affiliates.

For example: two reports "Massage Therapist" and "Magazine Publishing" should be named:
MassageTherapist.pdf and MagazinePublishing.pdf 

Create Your WordPress Plugin 

To create your plugin, click the button below then enter your details into the boxes as follows:

 
Click here To Create Your Wordpress Plugin



Item
Your brandable reports can contain up to six affiliate IDs and up to six links. Use the drop-down 
control to select an item and then enter the information for that item. Leave the entries blank for any 
unused items.

Description
Enter a brief description of the item that will be displayed when your affiliates are asked to enter their 
details. For example "Your affiliate ID" or "Link to your website".

Default ID (only for Affiliate ID items)
Enter the default affiliate ID to be inserted if the affiliate does not specify an ID. Leave the box blank if 
there is no default ID.

Replace Link (only for Link items)
Enter the link that is to be replaced by the affiliate's own link. The link must EXACTLY match the link 
in the PDF file. Example: http://www.mysite.com/

Domain Name
Enter the domain name for your website - for example mysite.com. If you are using the plugin on a 
subdomain, enter the full subdomain name.

Create Button
When you have filled in the boxes, click the Create button, then select where to save the new plugin 
files on your PC. The tool will create three new files, called affiliatepdf.php,  getpdf.php and .htaccess.

You must upload the files to your web host - see below for details of how to upload.

Please Note: You may use the plugin on all the websites you own, but you must not distribute, give 
away or sell the plugin (or any part of it).
 

Uploading And Activating The Plugin

Once you have created the plugin, you need to upload the three files to your blog and then activate the 
plugin follows:

1. You can use the Plugin Installer Tool below to upload the files. The files should be uploaded to a 
subfolder of the WordPress plugins folder. You can call the subfolder anything you want, but most 
people call it "affiliatepdf".

2. Activate the plugin through the "Plugins" menu in WordPress. 

Uploading Your Brandable PDFs

Your brandable PDF files should be uploaded to the same subfolder as the plugin. You can upload 
them using the Plugin Installer Tool below.

You can upload new PDF files at any time in the future - or delete PDF files - as required.



Your PDF files should have names with upper case letters at the start of each word. For example: 
MassageTherapist.zip and MagazinePublishing.zip.

 
Creating A Blog Post Or Page

Once you have activated your plugin and uploaded your PDF files, you need to create a post (or page) 
where affiliates can get their branded files.

Here's how to create a post/page. If you do not understand this description, just copy the example 
below and paste it into WordPress as a new post.

Create a post/page as normal.

The post will have two parts, divided by a line of at least 10 "=" characters.

The top part is shown initially and asks the affiliate to enter their details. It should contain the text 
%%affiliatepdf1%% which will be replaced with a small form where affiliates can enter the required 
information.

The bottom part is shown after the affiliate has submitted their details and shows a download link for 
each branded report. It should contain the text %%affiliatepdf2%% which will be replaced with the 
download links. 

Here's an example of what you will see:

Download our PDF reports as an easy way to promote our affiliate program.

The reports will be automatically customized with your details.

Please enter your details in the box below and then click the button...

%%affiliatepdf1%%

Click on the links below to download your branded PDF reports...

%%affiliatepdf2%%
 
Once you have created your post, your branding solution is ready for use. Anyone visiting that post (or 
page) will be able to download ready-branded copies of your PDF reports.
 

Issues with the Appearance of the Submit Form

The plugin shows a form where affiliates can enter their details. If there is more than one brandable 
item in your PDF files, the plugin will use an HTML table. This will work OK with most WordPress 
themes, but some themes apply special formatting to tables, which may affect the appearance of the 
table.



If you are unhappy with the appearance, you can try a different theme on your blog.

Alternatively, if you are a very advanced user, you can edit the affiliatepdf.php plugin file to change the 
raw HTML used in the table. Edit the text for $affiliatepdf_html1, $affiliatepdf_html2 and 
$affiliatepdf_html3. But please be careful, as it is very easy to break the plugin when editing this code.

 
WordPress Multisite - Advanced Users Only

WordPress Multisite allows you to set up a single installation of WordPress and then use it to operate 
lots of blogs. Most people do not use Multisite as it is more complex to set up than just using one 
installation of WordPress for each blog.

Multisite is usually used to operate blogs on different subdomains and/or addon domains. 

Multisite can also be used to operate blogs in different subfolders of the same domain, but very few 
people use that option and it is NOT supported by this software at all.

The information below assumes you are using Multisite to operate blogs on different subdomains 
and/or addon domains.

If you want to use the plugin on more than one blog, you must create a separate plugin for each blog 
using the tool above. Enter the relevant domain or subdomain name into the Domain Name box.

You must then upload each plugin to its own separate subfolder of the WordPress plugins folder, along 
with the relevant PDF files for that plugin.

When you visit the Plugins section of the blog admin, you will see separate entries for each of the 
plugins. Each plugin will have a name in the following format:

Affiliate PDF Plugin for mysite.com

(with the appropriate domain name or subdomain name in place of mysite.com)

You can then activate the relevant plugin on each blog separately. Note that you should NOT use the 
Network Activate option. You should only activate the plugin on the individual blog it was created for.

 

WordPress Theme And Plugin Installer Tools

 

These tools offer a quick and easy way to install themes and plugins. Note that use of these tools is 
optional. You can upload themes and plugins using the features built into Wordpress itself (if they 
work on your web host), or using any other uploading solution. 



Before using the Theme Installer, create a folder on your PC for your themes and put each theme in a 
suitably named subfolder of this folder. 

Before using the Plugin Installer, create a folder on your PC for your plugins and put each plugin in this 
folder - or in suitably named subfolders of this folder. 

Note that for the affiliate pdf plugin, you must upload all three files together in a subfolder of the 
WordPress plugins folder. You can call the subfolder anything you want, but most people call it 
"affiliatepdf". You can also upload your PDF files using the Plugin Installer Tool (just put the PDF 
files in the same subfolder). 

Click Here To Use The Theme Installer Tool

Click Here To Use The Plugin Installer Tool

Click the Browse button and select the folder containing your themes/plugins. 

The tool will upload everything that in that folder, including any subfolders.

If your blog is in a folder on your website, enter the name of the folder into the Folder On Web box 
(leave the box blank otherwise).

Click the FTP Setup button and enter your FTP details (domain name and your web host user name and 
password). These details will be remembered so it's even quicker to upload additional scripts in future.

Then just click the Upload button and everything will be uploaded. 

Notes On Entering Your FTP Details

The first time you use one of the tools, you need to enter the FTP details for your website. The two 
tools share this information, so you only need to enter it once.

Click the FTP Setup button to enter these details. You will need to know the user name and password 
for your web host. Your web hosting company should have provided these.

The tool automatically works out some of your web host settings, so it's easier to set up than normal 
FTP programs.

Please note that to use this software, you must have your domain name set up and working. This means 
that if you enter your web address (such as www.mysite.com) into your Internet browser, the browser 
must be able to find the site (even if it just displays a blank page). If your site is brand new, it may take 
a few hours before your domain name is fully set up and your browser can see it.

 

 



Using The Website Script

The website script is more complex to set up than the WordPress plugin, but if you are experienced 
with installing scripts, you should not have any problems.

You should have downloaded the script at the same time as this software as a separate zip file. The 
script is complete except for the config.php file, which is created using the tool below.
 
1. Creating An SQL Database

Before you can use the script, you need to create an SQL database on your web host. If you have an 
existing SQL database on your web host, you can use this if you wish (the script will simply add two 
new tables to the existing database).

If you want to create an SQL database, but don't know how, you should be able to ask your web 
hosting company to create one for you. They should send you the database name, user name and 
password values for the database, which you should enter into the software (see below).

If you would prefer to create the database yourself, you can view detailed step-by-step instructions on 
how to create an SQL database. You will need to be connected to the Internet to view the instructions. 
They are in the form of a PDF file, so you will need Adobe Acrobat installed on your PC in order to 
read them (click here to download Adobe Acrobat if you don't already have it installed). To read the 
instructions on how to create an SQL database, click here.

 
2. Choosing Your Installation Folder

The script must be installed into a folder on your website. You can call this folder anything you want. 
Example if your site is www.mysite.com and the script is installed in folder affiliates, your script web 
address would be http://www.mysite.com/affiliates/.

You will also upload your PDF files to this folder.

 
3. Decide Whether To Use Htaccess Mode

If your web host supports .htaccess files, you should use "Htaccess Mode". Most decent web hosts 
support .htaccess files. If you are unsure, you can try it to see if it works - and if your PDF download 
links do not work - or your whole script doesn't work - you'll then need to disable "Htaccess Mode".

To disable "Htaccess Mode", delete the .htaccess file that comes with the script and uncheck the "Use 
Htaccess Mode" checkbox in the config tool (see below). The only effect of disabling Htaccess Mode is 
that some very old browsers may have problems downloading the PDF files.
 
4. Create Your Config.php Script File

To use the software to create your script, click the button below then enter your details into the boxes 
as follows:
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Click Here To Create Your Config PHP File

Web Address Of Script
Enter the full web address of the folder where the script will be installed.
For example: http://www.mysite.com/affiliates

Use Htaccess Mode
This is normally left checked. See step 3 above for details.

SQL Details
Enter the SQL database name, SQL user name and SQL password for your database. The host entry is 
usually left as "localhost" and the table name is usually left as "pdffiles". 

Create Script Button
When you have filled in the boxes, click the Create Script button then select where to save the 
config.php file. This should be in the same folder on your PC into which you have already unzipped the 
rest of the script. 

You should then upload all the files to your web host. If you want to make any changes to the settings, 
just use the tool again and then upload the new config.php file in place of the existing one.
 

5. Customizing The Script Pages

If you are just creating reports containing a single affiliate ID to be customized, you don't need to do 
any customizing (unless you want to). If you are creating reports with multiple affiliate IDs and/or 
links, then you do need to customize (see below).

 

5a. Handling Reports With A Single Affiliate ID Only

You can replace the header.jpg and background.jpg files with your own header and background image 
if required, in order to make the affiliate area look more like your own website. If the new header is not 
the same size (700 x 130 pixels), you should edit index.html and index2.html with an HTML editor, to 
correct the header size.

You can also fully customize the pages seen by your affiliates if you wish, by editing the two files 
index.html and index2.html with any HTML editor. 

The index.html page is where the affiliate is asked to enter their affiliate ID.

The index2.html page shows a list of the available PDF files, with a download link for each. See 
section 5c below for details of how to edit index2.html.

 



5b. Handling Reports With A Multiple Affiliate IDs and/or Links

This is a little more complicated to set up and requires some basic knowledge of editing HTML.

You need to edit the page indexall.html and then rename it as index.html (replacing the old index.html).

You also need to edit the page index2all.html and then rename it as index2.html (replacing the old 
index2.html).
The indexall.html page is where the affiliate is asked to enter their affiliate IDs and links.

The supplied page has a form with six affiliate IDs and six links. Simply delete any that you don't want 
to use.

Each affiliate ID entry has the following HTML:

<TR><TD><FONT Face=Verdana size=2>Affiliate ID 1</FONT></TD>
<TD><INPUT type=hidden name=pdfao1 value='AAAA-Default1'>
<INPUT type=text width=45 name=pdfan1></TD></TR>

Change the text "Affiliate ID 1" to whatever text you want shown to the user.

Change the text "Default1" to the default affiliate ID to be inserted if the affiliate does not specify an 
ID.

The software normally uses "AAAA" as the text in the PDF file that is to be replaced by the first 
affiliate ID. If for some reason, you want to use something other than "AAAA" then just change 
"AAAA" to whatever text you want to use instead.

Each link entry has the following HTML:

<TR><TD><FONT Face=Verdana size=2>Link 1 </FONT></TD>
<TD><INPUT type=hidden name=pdflo1 value='http://www.mysite1.com/'>
<INPUT type=text width=45 name=pdfln1></TD></TR>

Change the text "Link 1" to whatever text you want shown to the user.

Change the text "http://www.mysite1.com/" to the link that is to be replaced by the affiliate's own link. 
The link you specify must exactly match the one in the PDF file.
 

5c. Editing The Index2.html Page (Optional)

The index2.html shows a list of the available PDF files, with a download link for each.

The list of available PDF files is added to the page automatically by the script in place of the text 
%%insert%%. Every time it is used, the script scans the folder containing the script and lists all PDF 
files found in that folder.



If you are using Htaccess Mode, you can manually insert the links to the PDF files instead of having 
them inserted automatically into the page. This allows you more flexibility so you can for example add 
a description next to each PDF file link.

To do this, remove the text %%insert%% and then add your own link for each PDF file. Just link to the 
file name of the PDF file - for example: report1.pdf. 

6. Create Your Database Table

Before the script will operate, you need to create the database table for the script by visiting the 
createdb.php page with your Internet browser.

For example if your script is installed at www.mysite.com/affiliates, you would visit 
http://www.mysite.com/affiliates/createdb.php
 

7. Uploading Your Brandable PDFs

Your brandable PDF files should be uploaded to the same folder as the script.

You can upload new PDF files at any time in the future - or delete PDF files - as required.

Your PDF files should have names with upper case letters at the start of each word. For example: 
MassageTherapist.zip and MagazinePublishing.zip.

 

8. Allowing Affiliates To Get Their Branded PDF Files

Once you have uploaded your PDF files, you can allow your affiliates to get their branded versions of 
them.

Just send your affiliates to the folder where the script is installed. For example: 
http://www.mysite.com/affiliates

Your affiliates will be asked for their affiliate ID. They will then be shown a list of all your brandable 
PDF files. They can click on any link and it will automatically download a copy of that PDF file with 
their affiliate ID inserted automatically.

 

Bonus Software Tool

Create .Exe PDF Branding Packages 

What This Bonus Software Does



This software allows you to create special branding packages for PDF files, which can then be passed 
to your affiliates (or users) to enable them to brand the PDF file.

The branding packages are executable (.exe) files that contain the PDF file along with special software 
to allow people to replace web addresses of links inside the PDF file with their own link information.

The .exe branding packages are potentially more flexible than using the automated PDF branding 
script. However the .exe branding packages are more difficult for affiliates to use than the automated 
PDF branding script.

To use the software, you select which links in the PDF file are brandable, so a PDF file can contain 
links that are not brandable as well as brandable links. Note that only the web addresses of links can be 
changed by branding. Link text cannot be changed. 

For example, let's say you have a PDF file containing a link with the text "Click Here For My Product" 
which links to web address http://www.mysite.com. It is not possible to change the text "Click Here 
For My Product", but your branding package will allow people to change the web address.

Note that this software requires a PDF file created using OpenOffice (or compatible software). 
OpenOffice is available free from http://www.openoffice.org

 

Use The Software

Click Here To Create an exe Branding Package

 To use this software, click the button above, then select the PDF file.

The software will find all the links in the PDF file and then present the links to you one at a time.

For each link, you can choose one of the options:
Not a brandable link  
Allow people to replace this with their own link 
Allow people to enter an affiliate ID to be inserted into the link
Many PDF files contain links that should not be modified, in addition to those that are to be made 
brandable. For such links, choose the first option (Not a brandable link).

The second option (Allow people to replace this with their own link) should be selected for any links 
where you want to allow your affiliates (or users) to replace the link with their own link. 

If you select this option, you should also enter suitable instructions so your affiliates (or users) know 
what the link is for. Here's some examples of instructions:

Your affiliate link
Your affiliate link for Amazon.com
Your affiliate link for the "Marketing Secrets" ebook
The link for your own website

http://www.openoffice.org/
http://www.openoffice.org/
http://www.openoffice.org/


When an affiliate (or user) brands the PDF file, they will see these instructions along with a box for 
them to enter their information. If they choose not to enter any information for that link, the original 
link in the PDF file will be left unchanged.

The third option (Allow people to enter an affiliate ID to be inserted into the link) should only be used 
in special cases (see below for more details).

Use the Next and Previous buttons to go through all the links. After you have viewed all the links, if 
you click Next again, the software will ask you where you want to save the new branding package on 
your PC.

The branding package is a new .exe file that actually contains the PDF file.

Give this .exe file to your affiliates. When they run it, it will ask them for the required information and 
then create a branded copy of the PDF and save it on their PC.
 

Inserting Links With Affiliate IDs

Instead of asking affiliates (or users) for a complete link, you can instead ask them for just their 
affiliate ID if you wish.

This can be useful if you want to make sure that people do not enter unsuitable links. 

It also allows you to include links for different products that use the same affiliate ID. 

For example, the popular Clickbank affiliate program allows you to promote lots of products using the 
same ID. You can ask the affiliate (or user) for their Clickbank ID, which can then be inserted into 
several different links for different products.

To do this, the original link inside the PDF file must be a complete affiliate link, but with "XXXX" in 
place of the affiliate ID.

For example, a typical affiliate link might look like this:

http://www.mysite.com/cgi-bin/affiliates/refer.cgi?r=XXXX

An example Clickbank link might look like this:

http://XXXX.myebook.hop.clickbank.net

When an affiliate (or user) brands the PDF file, they will be asked to enter their affiliate ID and then 
the software will replace XXXX with their affiliate ID.

Hence in our examples, if an affiliate (or user) entered an affiliate ID of myid, the example links would 
become:

http://www.mysite.com/cgi-bin/affiliates/refer.cgi?r=myid



http://myid.myebook.hop.clickbank.net 

To use this feature, you should select the third option (Allow people to enter an affiliate ID to be 
inserted into the link) for the link. This third option can only be selected in cases where the original link 
in the PDF file contains "XXXX" somewhere in the link.

If you select this option, you should also enter suitable instructions so your affiliates (or users) know 
what the link is for. You should also enter a default ID, which will be inserted into the link in the event 
that an affiliate (or user) does not enter any information.

Here's some examples of instructions:

Your affiliate ID
Your Clickbank ID
Your affiliate ID for Amazon.com

When an affiliate (or user) brands the PDF file, they will see these instructions along with a box for 
them to enter their information. If they choose not to enter any information for that link, your default 
affiliate ID will be inserted into the link.

You can have several different links using the same ID if you wish. To do this, enter the exact same 
instructions for each of the links.

The software will then only ask the affiliate (or user) for that information once and will brand all the 
links using that information.

For example, you could have the following links (for three different Clickbank products) in your PDF 
file:

http://XXXX.fishing.hop.clickbank.net
http://XXXX.crochet.hop.clickbank.net
http://XXXX.farming.hop.clickbank.net

You should enter the same instructions for each of these links (in this case, they should all use the 
instructions: "Your Clickbank ID"). Affiliates (or users) would then be asked to enter their Clickbank 
ID once and then all the links would be updated using that ID.

Version History 

This software will occasionally connect to the Internet (when it is able to) and automatically check for 
new versions. All new versions can be downloaded automatically at no extra cost.

Version 1.1 - Original version

Version 1.2 - New version with WordPress support



Requirements: The Dispenser script setup software is for use only on PCs running Microsoft 
Windows. The Dispenser script itself requires a web host that supports PHP and SQL (most quality 
web hosts support these as standard).
 

This software is for your personal use only and must not be distributed

Affiliate PDF Dispenser provides a quick and easy solution to make your reports instantly brandable in 
a way that even a complete newbie affiliate can use. Although the Dispenser script is easy for you and 
your affiliates, there may still be times when you prefer to use a traditional .exe PDF branding tool 
instead. 
So a bonus copy of our Affiliate PDF Brander - one of the best traditional brander tools on the market - 
is included.  This software really is a very valuable asset for anyone serious about online business.

For any questions or comments, please feel free to contact us.

http://thebestofwww.com/contactus.html
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